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Today’s Learning Goals

Familiarity with R’s basic syntax.
Familiarity with major R data structures.
Understand the basics of using functions.

Be able to use R to read and parse comma-separated
(.csv) formatted files ready for subsequent analysis.

Appreciate how you can use R scripts to aid with
reproducibility.

Recap From Last Time:

Substitution matrices: Where our alignment match and mis-match
scores typically come from

Comparing methods: The trade-off between sensitivity, selectivity
and performance

Sequence motifs and patterns: Finding functional cues from
conservation patterns

Sequence profiles and position specific scoring matrices (PSSMs),
Building and searching with profiles, Their advantages and
limitations

PSI-BLAST algorithm: Application of iterative PSSM searching to
improve BLAST sensitivity

Hidden Markov models (HMMs): More versatile probabilistic model

for detection of remote similarities
Feedback




What is R?

R is a freely distributed and widely
used programing language and
environment for statistical computing,

data analysis and graphics.

R provides an unparalleled interactive

environment for data analysis.
It is script-based (i.e. driven by

computer code) and not GUI-based
(point and click with menus).

4, sandbox (R)

pico:sandbox> R < —————

Type “R” in your terminal

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type '"license()' or 'licence()' for distribution details.

Natural language support but running in an English locale
R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

|

4, sandbox (R)

pico:sandbox> R

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.

Type '"license()' or 'licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.

Type 'contributors()' for more information and

'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or

'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

|

4, sandbox (R)

ico:sandbox> R —— “pY )
P Type “R” in your terminal

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type '"license()' or 'licence()' for distribution details.

Natural language support but running in an English locale
R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'q()' to quit R.

> || G— This is the R prompt




O 4, sandbox (R)

pico:sandbox> R < ————— P .
Type “R” in your terminal

R version 3.2.2 (2015-08-14) -- "Fire Safety"

Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl3.4.0 (64-bit)

|R is free software and comes with ABSOLUTELY NO WARRANTY.|
You are welcome to redistribute it under certain conditions.
Type '"license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type |'q()' to quit R|

> 1 <4——— This is the R prompt: Type q() to quit!

What about Excel?

Data manipulation is easy

Can see what is happening
But: graphics are poor
Looping is hard

Limited statistical capabilities

Inflexible and irreproducible — Use the right tooll

There are many many things Excel just cannot do!

What R is NOT

A performance optimized software library for
incorporation into your own C/C++ etc. programs.

A molecular graphics program with a slick GUI.
Backed by a commercial guarantee or license.

Microsoft Excel!

Christie Bahlai
Weekly plug for scripted analyses:

Coauthor: "Can you change x,y,z about the analysis?"
Me [not crying]: "Yes." [changes 2 lines of code]

MEERX

Rule of thumb: Every analysis you do on a dataset
will have to be redone 10—15 times before publication.
Plan accordingly!




Why use R?

Productivity
Flexibility

Designed for data analysis

Modularity

Core R functions are modular and work
well with others

Interactivity

R offers an unparalleled exploratory
data analysis environment

Infrastructure

Access to existing tools and cutting-
edge statistical and graphical methods

Support

Extensive documentation and tutorials
available online for R

R Philosophy

Encourages open standards and
reproducibility

R is designed specifically
for data analysis

* Large friendly user and developer community.

* As of Jan 6th 2019 there are 13,645 add on
R packages on CRAN and 1,649 on
Bioconductor - much more on these later!

* Virtually every statistical technique is either
already built into R, or available as a free

package.

* Unparalleled data analysis environment for
high-throughput genomic data.

Modularity

Core R functions are modular and work
well with others

Interactivity

R offers an unparalleled exploratory
data analysis environment

Infrastructure

Access to existing tools and cutting-
edge statistical and graphical methods

Support

Extensive documentation and tutorials
available online for R

R Philosophy

Encourages open standards and
reproducibility




Modularity

R was designed to allow users to interactively build complex
workflows by interfacing smaller ‘modular’ functions
together.

An alternative approach is to write a single complex
program that takes raw data as input, and after hours of
data processing, outputs publication figures and a final
table of results.

Advantages/Disadvantages

The ‘monster approach’ is customized to a particular project
but results in massive, fragile and difficult to modify (therefore
inflexible, untransferable, and error prone) code.

With modular workflows, it’s easier to:

» Spot errors and figure out where they’re occurring by
inspecting intermediate results.

» Experiment with alternative methods by swapping out
components.

» Tackle novel problems by remixing existing modular
tools.

Which would you prefer and why?

Modular

VS

‘Scripting’ approach
Another common approach to bioinformatics data analysis

is to write individual scripts in Perl/ Python/Awk/C etc. to
carry out each subsequent step of an analysis

> BRI

This can offer many advantages but can be challenging to
make robustly modular and interactive.




Interactivity & exploratory data analysis

Learning R will give you the freedom to explore and
experiment with your data.

“Data analysis, like experimentation, must be considered as
a highly interactive, iterative process, whose actual steps
are selected segments of a stubbily branching, tree-like
pattern of possible actions”. [J. W. Tukey]

Interactivity & exploratory data analysis

Learning R will give you the freedom to explore and
experiment with your data.

“Data analysis, like experimentation, must be considered as
a highly interactive, iterative process, whose actual steps
are selected segments of a stubbily branching, tree-like
pattern of possible actions”. [J. W. Tukey]

Bioinformatics data is intrinsically high dimensional and
frequently ‘messy’ requiring exploratory data analysis to
find patterns - both those that indicate interesting biological
signals or suggest potential problems.

Input sequence or structure
aa = get.seq("1rx2_A")

!

BLAST or HMMER search
hits = blast(aa)

!

Download related structures
files = get.pdb(hits)

Align structures
:

o

i

Input user fuvr 8- Input simulation
specific PDBs pdbs = pdbaln(files) trajectory
Ensemble NMA Ensemble PCA & addational
% . sequence/structure analysis

pc = pca(pdbs)
# conserv() rmsd()
modes = nma(pdbs) # rms£() dcem() etc.

Fluctuation analysis Correlation networks; X-ray & MD PCA
S @ B
M AN % ‘ k.
[V E W e --
plot (modes) cna(cij) plot(pc)
Clustering PCA vs NMA
4 -
! 5

heatmap (modes) rmsip (pe,modes)

R Features = functions|()
SRR

BLAST or HMMER search
hits = blast(aa)

!

Download related structures
files = get.pdb(hits)

Align structures
——

rvvLcs scvalls- L

Input user Juv v i Input simulation
specific PDBs pdbs = pdbaln(files) trajectory
Ensemble NMA Ensemble PCA & addational

sequence/structure analysis

pc = pca(pdbs)
# conserv() rmsd()
modes = nma(pdbs) # rms£() dcem() etc.
Fluctuation analysis Correlation networks; X-ray & MD PCA

L B

M ASN

s
[NV .
plot (modes) cna(cij) plot(pc)

Clustering PCA vs NMA

f -'-

heatmap (modes) rmsip (pe,modes)




Two main ways to use R

ndbox (R)
pico:sandbox> R

R version 3.2.2 (2015-08-14) -- "Fire Safety"
Copyright (C) 2015 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwin13.4.0 (64-bit) s

R is free software and comes with ABSOLUTELY NO WARRANTY. 2.4 1- Code Editor

You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

H ow d o We u Se R : Natural language support but running in an English locale
u

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
"citation()" on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type 'qQ)' to quit R.

>l

1. Terminal 2. RStudio

[3- Workspace and L g ‘ [3- Workspace and
History ‘ History

Tes Pot  Pacages Melp Tes Pot  Pacages Melp

eom  Hlpcas O Coeae & eom  Hlpcas O Coeae &

Diamond Pricing Diamond Pricing




Tools > Global Options

* We will NOT save our workspace...

Options

Default working directory (when not in a project):
General
Browse...

Code
/|Re-use idle sessions for project links

. Appearance + Restore most recently opened project at startup

v Restore previously open source documents at startup

Pane Layout
Restore .RData into workspace at startup

Packages save workspace to .RData on exit: { Never %

R Markdown (/| Always save history (even when not saving .RData)

li ntries in h
Sweave Remove duplicate entries in history

Show .Last.value in environment listing
% Spelling

v Use debug error handler only when my code contains errors
W Giusw Automatically expand tracebacks in error inspector

T .
& Publishing Wrap around when navigating to previous/next tab

W Terminal ) Automatically notify me of updates to RStudio

Lets get started...

L TE =1 RN A Go to file/function B8 - Addins -

Console  Terminal - Jobs Environment  History ~ Connections =0

(=
~/Desktop/test/tmp/ # - & M |E ImportDataset - | ¢ =tst- | C-

@ Global Environment Q

R version 3.6.0 (2019-@4-26) -- "Planting of a Tree"

Copyright (C) 2019 The R Foundation for Statistical Computing

Platform: x86_64-apple-darwinl5.6.0 (64-bit) Environment is empty

R is free software and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.

Type 'license()' or 'licence()' for distribution details. i Fet=Nl fackages | Shie Il Viewer =0
+f New Folder | xJj Delete [y Rename | ¥ More - C'

Natural language support but running in an English locale »a H°l":)n“k‘°")““ AT - LI
jame ize

(g

R is a collaborative project with many contributors. B ® mpRroro) 50

Type 'contributors()' for more information and
"citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'qgQ)" to quit.R

"Console"

Tools > Global Options

» [Optional] Change to dark Appearance and
increase font size, etc. ..

Options.

oo RStudio theme:
eneral Mod i

odern plot <- function (x, y, ...
Code

: {
p— e %3 if (is.function(x) &&
I Appearance § .o oco is.null(attr(x, "clas
pame L Monaco $ {
ane Layout ; issi
Edior o s if (missing(y))
Packages 3 4 y <- NULL

Editor theme:
Ambiance .
Chaos hasylab <- function(...

@ sweave Chrome 1 :
o lall(is.naC

¢ Spelling Clouds.Midnight. pmatch(names(list(.
Cobalt 5 2
“Crimson Eaitor ' ylab")))

W Giusw Dawn
Do if (hasylab(...))

~ :
S Publishing ‘E’;:':ewea“' plot. function(x, vy, .

Idle Fingers

else

Material plot. function(
Merbivore

X, ¥,
L ylab = paste(
deparse(substitut
"GO™

@ RMarkdown

B Terminal

Some simple R commands

/ R prompt, don't type this!

By
[1]

> exp (1)

[1] 2.718282

> log (2.718282)
[1] 1

> 1log (10,| base=10)

[1] 1 Optional
argument

Result of the
command

> log (10

, base = 10)
Orderdof [1](1\ Incomplete comman
precedence
> x=1:50

> plot(x, sin(x))
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Does your plot look like this?




rning a new
je is har

Error Messages

Sometimes the commands you enter will generate errors.
Common beginner examples include:

* Incomplete brackets or quotes e.g.
(44820 <enter> Your turn!
+
This eturns a + here, which means you need to enter the remaining
bracket - R is waiting for you to finish your input.
Press <ESC> to abandon this line if you don't want to fix it.

https://bioboot.github.io/bggn213 W20/class-material/lab-4-bggn213/

+ Not separating arguments by commas e.g. If you have done the introductory DataCamp course
plot(1:10 col="red") then feel free to jump to section #3 Object Assignment
* Typos including miss-spelling functions and using wrong type of brackets

e.g.
exp{4}




Topics Covered:

Calling Functions
Getting help in R
Vectors and vectorization
Workspace and working directory
RStudio projects

Vectors

* Vectors are the most basic data structure in R
* All elements of a vector must be the same type

dbl_var <- c(1, 2.5, 4.5) [ [
log_var <- ¢(TRUE, FALSE, T, F) 1 1 [
chr_var <- c("these are", "some", "strings") i

» When you attempt to combine different types they will
be coerced to the most flexible type.

var <- ¢(1, 'G", "4", 0.05, TRUE) 1 1 [

Topics Covered:
Calling Functions
Getting help in R
Vectors and vectorization
Workspace and working directory
RStudio projects

Names

* You can name a vector in several ways:
 When creating it: [x<ec@=1,b=2c-38) [HiEN
* By modifying an existing vector in place:
X <- 1:3; names(x) <- c("a", "b", "c")

* You can then use the names to access a subset
of vector elements:

x[c("o’, "a") ] 1




Why is this useful?

» Because if you know the name (i.e. your label)
then you don’t have to remember which element
of a vector the data you are after was stored in.
Consider this fictional example:

~ grades <- c(alice=80, barry=99, chandra=60, chris=100)
~ grades["barry"]
barry

99
~ which.max(grades)
chris

4
~ sort(grades)
chandra alice barry chris

60 80 99 100

data.frame E88

data.frame is the de facto data structure for
most tabular data and what we use for statistics
and plotting with ggplot2 - more on this later!

Arguably the most important R data structure

Data frames can have additional attributes such
as rownames() and colnames(), which can be
useful for annotating data, with things like
subject_id or sample_id

R has many data
structures

These include:

e vector
data frame
list
matrix
factors

1]
HEN
LLLL

data.frame continued. 'S

» Created with the function data.frame()

dat <- data.frame(id = letters[1:10], x = 1:10, y = 11:20)

* Or more commonly when reading delimited files
(i.e. importing data) with the functions
read.csv(), read.table(), read_xIsx() etfc...

dep <- read.csv2("http://bio3d.uib.no/data/pdb_deposition2.csv")




Useful data.frame Functions

* head() -and tail() shows first 6 rows and last 6 rows

respectively

* dim() - returns the dimensions (i.e. number of rows and

columns)

* nrow() and ncol() returns the number of rows and

columns separately.

* rownames() and colnames()- shows the names attribute

for rows and columns

» str() - returns the structure including name, type and

preview of data in each column

Topics Covered:

Calling Functions
Getting help in R
Vectors and vectorization
Workspace and working directory
RStudio projects

Key Points

* R’s basic data types are logical, character,
numeric, integer and complex.

* R’s basic data structures include vectors, lists,
data frames, matrices and factors.

» Objects may have attributes, such as name,
dimension, and class.

Topics Covered:

Calling Functions
Getting help in R
Vectors and vectorization
Workspace and working directory
RStudio projects




Side-note: Use the code
editor for R scripts

Files Plots Packages Help Viewer

frrens “ +8 New Folder | 'l Delete [y Rename | & More -
" : " m
Code Editor @ A Home > Desktop > test > tmp
_ ,  Name size
E

RSciptsl @ @ tmp.Rproj

~IDesktop/test/tmp/ e
R is a collaborative project with many contributors.

Type 'contributors()' for more information and

'citation(D' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
'help.start()' for an HTML browser interface to help.
Type 'qQ)' to quit R.

> X <

= =

Side-note: RStudio shortcuts

@71 lecture.r* | faithful

B [Fsourceonsave | Q / ~
1 view(faithful) .
2 plot(faithful)
3

Sends current line or
selection to console (faster
to type:

command/ctrl+enter ) Sends entire

file to console

Other RStudio shortcuts! Re-send the lines of
Up/Down arrows (recall cmds) code you last ran to the
Ctrl + 2 (move cursor to console) console
Ctrl +1 (move cursor to editor) (useful after edits)

R scripts

A simple text file with your R commands (e.g. lecture?.r)
that contains your R code for one complete analysis

Scientific method: complete record of your analysis

Reproducible: rerunning your code is easy for you or
someone else

In RStudio, select code and type <ctrl+enter> to run the
code in the R console

Key point: Save your R script!

Rscript: Third way to use R

my_analysis.R

1. Terminal 2. RStudio 3. Rscript

From the command line!
> Rscript --vanilla my_analysis.R
# or within R: source(my_analysis.R)



R workspaces

When you close RStudio, SAVE YOUR .R SCRIPT

You can also save data and variables in an R workspace, but
this is generally not recommended

Exception: working with an enormous dataset

Better to start with a clean, empty workspace so that past
analyses don't interfere with current analyses

rm(list = Is()) clears out your workspace or use the broom icon

You should be able to reproduce everything from your R script,
so save your R script, don’t save your workspace!

Learning Resources

TryR. An excellent interactive online R tutorial for beginners.

< http://tryr.codeschool.com/ >

RStudio. A well designed reference card for RStudio.
< https://help.github.com/categories/bootcamp/ >

DataCamp. Online tutorials using R in your browser.
< https://www.datacamp.com/ >

R for Data Science. A new O’Reilly book that will teach you
how to do data science with R, by Garrett Grolemund and
Hadley Wickham.

< http://rd4ds.had.co.nz/ >

RStudio Projects

» We will use a new RStudio project for each new class going

forward.

File > New Project > New Directory > New Project...

* These projects will help keep us organized and divide our

work into multiple contexts, each with their own working
directory, workspace, history, and source documents.

Learning Resources

TryR. An excellent interactive online R tutorial for beginners.
< http://tryr.codeschool.com/ >

RStudio. A well designed reference card for RStudio.
< https://help.github.com/categories/bootcamp/ >

DataCamp. Online tutorials using R in your browser.
< https://www.datacamp.com/ >

R for Data Science. A new O’Reilly book that will teach you
how to do data science with R, by Garrett Grolemund and
Hadley Wickham.

< http://rdds.had.co.nz/ >




< https://www.datacamp.com/ >

Key Points

https://www.datacamp.com/home

DataCamp Learn v Groups About v 1,250XP . B S 3
oo a et R’s basic data types are logical, character,

Your Latest Activity . numeric, integer and complex.

You have a new assignment:
Working with the RSt...

Introduction to Spark in R using b _ : .
‘ N R’s basic data structures include vectors, lists,

e data frames, matrices and factors.

bigrant invited you to the
groupFoundations o...
16 days ago

Objects may have attributes, such as name,

o dimension, and class.

See all notifications

DataCamp, StackOverflow and help() are your
e Ce—— friends.

Final Knowledge Check!

What is R and why should we use it?

Familiarity with R’s basic syntax.

Please complete:
Muddy point assessment

Familiarity with major R data structures namely vectors and
data.frames (with more on lists and matrices next day).

Understand the basics of using functions (arguments,
vectorizion and re-cycling).

Be able to use R to read and parse comma-separated (.csv)
formatted files ready for subsequent analysis.

Appreciate how you can use R scripts to aid with reproducibility.




Reference Slides:

Matrix
Vector

Array

117

N
— ¢j

NS

Data Frame columns
(Table)

Lists

| Variables | Example |

integer 100
numeric 0.05
character “hello”

logical TRUE

factor “Green”

(69, 619, 67179
===l

Vector

CrrT 1T 171

Matrix Data frame

Help from within R

* Getting help for a function
help ("log")
?1og

» Searching across packages
> help.search("logarithm")

* Finding all functions of a particular type

> apropos ("log")

[7] "SSlogis" "as.data.frame.logical"™ "as.logical"
"as.logical.factor" "dlogis" "is.logical"

[13] lllogll "lOglO" llloglp" lllogzll lllOgLikll lllogb"

[19] "logical" "loglin" "plogis" "print.logLik" "glogis"
"rlogis™"

>
>

R: Logarithms and Exponentials v

log {base} R Documentation

Logarithms and Exponentials

1og computes logarithms, by default natural logarithms, 1og10 computes common (i.e., base
10) logarithms, and 1og2 computes binary (i.e., base 2) logarithms. The general form log (x,
base) computes logarithms with base base

1ogip (x) computes log(1+x) accurately also for [x
approximately -1).

(and less accurately when x is

exp computes the exponential function
expml (x) computes exp(x) - 1 accurately also for x| << 1
How to use the function

log(x, base = exp(1))
logb(x, base = exp(1))

loglp (x)

exp (x)
expri (x)

What does the function need

X anumeric or complex vector.

base a positive or complex number: the base with respect to which logarithms are computed.
Defaults to e=exp (1)

Details

All except 1ogb are generic functions: methods can be defined for them individually or via the
Math group generic.

10g10 and 10g2 are only convenience wrappers, but logs to bases 10 and 2 (whether
computed via 1og or the wrappers) will be computed more efficiently and accurately where
supported by the OS. Methods can be set for them individually (and otherwise methods for 1og
will be used)

logb is a wrapper for 1og for compatibility with S. If (S3 or S4) methods are set for 1og they
will be dispatched. Do not set S4 methods on Logb itself

All except 1og are primitive functions

. I Og
R: Logarithms and Exponentials v

What does the function return

What the function does in general terms  avector of the same length as x containing thetransformed values. 103 () gives ~Tne, and

1og (x) for negative values of x is NaN. exp (-Inf) is 0

For complex inputs to the log functions, the value is a complex number with imaginary part in
the range [-pi, piJ: which end of the range is used might be platform-specific

$4 methods

exp, expml, log, 10g10, 1og2 and loglp are S4 generic and are members of the Macn
group generic

Note that this means that the S4 generic for og has a signature with only one argument, x
but that base can be passed to methods (but will not be used for method selection). On the
other hand, if you only set a method for the Mach group generic then base argument of log
will be ignored for your class

Source

1ogip and expm1 may be taken from the operating system, but if not available there are
based on the Fortran subroutine d1nze1 by W. Fullerton of Los Alamos Scientific Laboratory
(see http://www netlib org/slatec/fnlib/dinrel f and (for small x) a single Newton step for the
solution of 1og1p (v) = x respectively.

References

Becker, R. A., Chambers, J. M. and Wilks, A. R. (1988) The New S Language. Wadsworth &
Brooks/Cole. (for 10g, 1010 and exp.)

Chambers, J. M. (1998) Programming with Data. A Guide to the S Language. Springer. (for
logb.)

Discover other related functions

hmetic

Sample code showing how it works

x <=

A= (1 9)
cbind(x, log(1+x), loglp(x), exp(x)-1, expml(x))

[Package base version 3.0.1 Index]




Optional Exercise

Use R to do the following. Create a new script to save
your work and code up the following four equations:

1+2(3+4)
In(43+32+1)

(4+3)(2+1)

142\
(5+4)




